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Abstract
Current Graphical User Interface (GUI) agents
have achieved outstanding performance in GUI
element grounding. However, planning remains
highly challenging, especially due to sensitivity to
the initial state of the environment. Specifically,
slight differences in the initial state—such as the
target software not being open or the interface not
being in its default state—often lead to planning
errors. This issue is widespread in real applica-
tion scenarios, but existing benchmarks fail to
evaluate it. In this paper, we present WorldGUI, a
novel GUI benchmark that designs GUI tasks with
various initial states to simulate real computer-
user interactions. The benchmark spans a wide
range of tasks across 10 popular software applica-
tions, including PowerPoint, VSCode, and Adobe
Acrobat. In addition, to address the challenges
of dynamic GUI automation tasks, we propose
GUI-Thinker, a holistic framework, leveraging
a critique mechanism, that effectively manages
the unpredictability and complexity of GUI in-
teractions. Experimental results demonstrate that
GUI-Thinker significantly outperforms Claude-
3.5 (Computer Use) by 14.9% in success rate on
WorldGUI tasks. This improvement underscores
the effectiveness of our critical-thinking–based
framework in enhancing GUI automation.

1. Introduction
Graphical User Interface (GUI) automation has become a
prominent research area, driven by the need to enhance user
productivity. This domain encompasses software usage,
file management, office design, coding, and web brows-
ing. Building upon Multimodal Large Language Models
(MLLMs) such as GPT-4o (OpenAI, 2023) and Claude-3.5
(Anthropic, 2024), GUI agents have the potential to solve
various computer tasks to avoid repetitive work or as an AI
assistant to help the user.
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Figure 1. The comparison of static and dynamic testing processes.
Our WorldGUI takes the first step to facilitate comprehensive GUI
evaluation with various initial states. The red node represents an
incorrect state.

GUI automation operates in a dynamic environment, which
goes beyond the traditional computer vision tasks like image
recognition (He et al., 2016) and visual question answering
(Antol et al., 2015). However, current GUI benchmarks
such as OSWorld (Xie et al., 2024) and WebArena (Zhou
et al.) do not capture this dynamism. As shown on the left
side of Fig. 1, most GUI benchmarks focus on initial and
final states, measuring success rates but overlooking the
changing initial conditions present in real GUI scenarios.
These benchmarks often ignore situations where: (1) The
software interface is not in its default state. (2) The agent
might get user queries at any time. (3) Differences in agent
robustness, where agents with the same low success rate (e.g.
20%) may vary in their ability to self-verify or self-correct,
but these abilities are not measured in a static setting. As a
result, these benchmarks fail to fully assess the capabilities
of GUI agents.

In this paper, we take the first step toward comprehensive
GUI agent testing by designing GUI tasks with various ini-
tial states. As illustrated on the right side of Fig. 1, the
testing process of WorldGUI can be featured: (1) Inter-
mediate Starting States: Real user interactions with GUI
assistants do not always begin from default conditions, al-
lowing tasks to start from intermediate states where users
may seek assistance at any point (see Fig. 1 (b)). (2) Contex-
tual Variability: In some cases, tasks may originate from
entirely different contexts or interfaces, requiring the agent
to adapt by modifying existing steps (see Fig. 1 (c)) or intro-
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ducing new steps (see Fig. 1 (d)) to ensure task progression.
By incorporating these elements, WorldGUI better mirrors
real-world GUI environments, enabling a more accurate and
thorough assessment of GUI agent capabilities.

Specifically, we present WorldGUI, a new benchmark fea-
turing 10 desktop software applications and 315 tasks, in-
cluding PowerPoint, Word, Excel, VSCode, etc. For each
task, we provide a user query, an instructional video, and
the corresponding project file. To ensure the task quality,
we engaged four trained annotators skilled in using these
applications and proficient in constructing data with scripts
and agents for annotation. To stimulate the dynamic testing
scenarios, we demonstrate each task to obtain ground-truth
(GT) plans and then conduct the augmentations for each
task using pre-actions. (See details in Sec. 3.)

In addition, we introduce a novel GUI agent framework,
GUI-Thinker, which builds upon critical thinking philos-
ophy, an aspect less emphasized in previous GUI agents
(Hong et al., 2024; Cheng et al., 2024; Lai et al., 2024;
Agashe et al., 2024; Wu et al., 2024). In dynamic GUI
environments, application settings may not be in default
configurations. This unpredictability requires agents to have
the essential ability to detect and adapt to such changes to
ensure task accuracy. Through our analysis of real-world
GUI scenarios, we identify three critical designs for a com-
prehensive agent: (1) Post-Planning Critique, (2) Pre-
Execution Validation, and (3) Post-Action Evaluation.
Specifically, GUI-Thinker comprises five core components:
Planner, Planner-Critic, Step-Check, Actor, and Actor-Critic.
We argue that these components are fundamental for effec-
tive GUI agents.

To summarize, our key contributions are the following: (1)
We are the first to stress the dynamic testing processes in
GUI automation and propose a new benchmark WorldGUI
which designs the GUI tasks with various initial states
to simulate the real interactions; (2) We introduce GUI-
Thinker, a comprehensive GUI framework. GUI-Thinker
incorporate the thinking into the overall agent design, which
provides valuable insights and guidance for future devel-
opment; (3) We explore the essential property of critical
thinking in GUI agents and empirically show that critical
thinking is extremely useful for handling complex tasks.

2. Related Work
2.1. GUI Benchmarks

GUI benchmarks are essential for evaluating the perfor-
mance and robustness of GUI agents. For web applications,
WebShop (Yao et al., 2022), and WebArena (Zhou et al.)
are two text-based GUI benchmarks, the GUI information
is formatted in the text style which is limited to reflect
the dynamic GUI state changes. In OS environments, OS-

World (Xie et al., 2024) is a comprehensive benchmark
including various operating systems with real applications.
Mobile benchmarks MobileAgent (Wang et al., 2024) and
AppAgent (Zhang et al., 2023) propose two GUI bench-
marks of mobile applications. Windows-related bench-
marks like AssistGUI (Gao et al., 2024) and WindowA-
gentArena (Bonatti et al., 2024) propose a list of real tasks
in the Windows platform. However, these benchmarks pri-
marily rely on a static testing process and do not adequately
capture the complexity and dynamic nature of GUI environ-
ments. As a result, they are insufficient for comprehensively
evaluating GUI agents. We summarize the differences be-
tween WorldGUI and other related benchmarks in Tab. 5.

2.2. GUI Agents

Building upon MLLMs, GUI agents have the potential
to solve various computer tasks to avoid repetitive work
or as an AI assistant to help the user. CogAgent (Hong
et al., 2024) is a vision language model focused on
GUI understanding to facilitate GUI navigation, while
SeeClick (Cheng et al., 2024) and SeeAct (Zheng et al.,
2024) focus on the GUI grounding for enhancing the task
performance. MobileAgent (Wang et al., 2024) and AppA-
gent (Zhang et al., 2023) are proposed to design the agent on
mobile device. Ferret-UI (You et al., 2025) is another repre-
sentative work focusing on enhancing the grounding ability
in the IOS platform. AutoGLM (Liu et al., 2024) propose the
GUI modes capable of learning through autonomous envi-
ronmental interactions by reinforcing existing GUI models.
These agents have shown their ability in GUI understand-
ing (e.g., GUI elements grounding) or action prediction but
still face limitations in handling dynamic and complicated
full GUI tasks. Therefore, to enhance GUI automation in
dynamic environments, we propose GUI-Thinker that im-
proves adaptability in complex GUI settings and enables
agents to effectively handle unpredictable interface changes.

2.3. Critical Thinking in Agents

Recent advancements in foundation models and agents, par-
ticularly in LLMs such as OpenAI-o1 (OpenAI, 2024) and
Deepseek-R1 (DeepSeek-AI et al., 2025), have increasingly
incorporated thinking processes before providing answers
to effectively handle challenging reasoning tasks. The LLM-
based agents utilize verify-then-correct process to evaluate
and refine intermediate reasoning steps or outputs, ensuring
logical coherence and consistency. One notable LLM-based
agent framework, Reflexion (Shinn et al., 2024), demon-
strates the effectiveness of self-reflection in solving com-
plex tasks. Furthermore, Critic (Gou et al., 2023) integrates
external tools into the critique process, leveraging them to
improve performance. Noticing the GUI task is lengthy
and complicated, the verify-then-correct process is highly
suitable for the GUI scenario. Which is not only aims to
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Figure 2. WorldGUI: An illustration of our proposed real-world GUI benchmark. The left shows that for each task, WorldGUI provides a
user query, instructional video, and pre-actions. The pre-actions lead to different initial states. The key characteristic of our WorldGUI
is the various initial states of the same task to stimulate the real-world testing process. The right shows the software included in our
benchmark and the interactions about testing the agents in our GUI environment.

enhance the reasoning performance but also indispensable
to designing the key module Actor-Critic (Konda & Tsitsik-
lis, 1999) to ensure task completion. A closely related work,
AssistGUI (Gao et al., 2024), integrates a critical module
only after the Actor module to evaluate action completion.
Building upon it, we introduce two additional critical mod-
ules: Planner-Critic, applied after the Planner, and Step-
Check, applied before the Actor. These two modules lead
to a comprehensive and fundamental GUI agent framework
GUI-Thinker which will provide insights for future GUI
agent design.

3. WorldGUI Benchmark
3.1. Task Formulation

GUI Automation Definition. The GUI automation task can
be considered a partially observable Markov decision pro-
cess (POMDP) (S,O,A, T ,R) with state space S , observa-
tion O, action space A, transition function T : S ×A → S ,
and reward function R: S ×A → R. In our setting, given a
natural language query q, eg., Format the slide background
with gradient fill that describes a specific task in high-level,
along with an instructional video v as a supplement that
more detailed illustrates how to complete it, the agent first
get the observation ot ∈ O from the state st ∈ S in the
execution environment and then generate the executable ac-
tion at ∈ A, resulting in a new state st+1 ∈ S and a new
observation ot+1 ∈ O. The process repeats until the task is
finished or failed. The reward function R: S ×A → [0, 1]
here returns a binary integer at the final step indicating the
task completion status.

WorldGUI Task Definition. As illustrated in Fig. 2, each
GUI task is paired with a user query and an instructional
video. To achieve state diversity within each task, we gener-
ate various initial states that converge to the same final state,
resulting in distinct ground truth (GT) plans for each case.
This is accomplished through the use of pre-actions, which
consist of a sequence of executable code to initialize tasks

from different initial states. With the augmentation of ini-
tial states, WorldGUI is capable of mimicking the different
testing scenarios as shown in Fig. 1.

Observation Space. The observation space O indicates
the information of the operating system (OS) available to
the agent in each state st. In our WorldGUI settings, we
follow the previous work AssistGUI (Gao et al., 2024), en-
compassing two types of information: metadata mt from
the application and screenshot Vt of current state st. The
metadata mainly includes the layout of panels and pop-up
windows. The screenshot Vt offers holistic visual infor-
mation of the current state used for planning and action
generation.

Action Space. Our action space includes all raw mouse
and keyboard actions, such as left-click, right-click, double-
click, drag, keystrokes, and key combinations for short-
cuts, among others. Mouse-related actions also spec-
ify the target position in the pixel space of the observed
screenshot. To ensure a universal and comprehensive
representation of actions, we adopted the widely used
Python library, PyAutoGUI, for controlling mouse and key-
board inputs. Each action is represented using the syntax
action type(arguments) as in Tab. 6.

3.2. Data Collection

3.2.1. DATA SOURCE

WorldGUI consists of a broad spectrum of desktop applica-
tions, which can be categorized into five main groups: (i)
Office work, includes PowerPoint, Word, Excel, and Adobe
Acrobat; (ii) Windows Usage, includes System Settings and
File Management; (iii) Web Browsing, includes the configu-
ration of Youtube and website operations; (iv) Coding, focus
on the customization, configuration and editing of Visual
Studio Code (VSCode); (v) Media Creation, uses the AI tool
like Stable Diffusion to create or edit the image or videos
by following user instruction.
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Task 1: Adjust text wrapping around a Word table
Subtask 1: Click within the table to select it.
Subtask 2: Click on the 'Layout' tab in the toolbar.
Subtask 3: Click 'Properties' from the options available.
…

Task 1: Adjust text wrapping around a Word table
Subtask 1: Click on the 'Table Layout' tab in the 
toolbar.
Subtask 2: Click within the table to select it.
Subtask 3: Click 'Properties' from the options 
available.
…

3. Step-Check
Check the task completion and redundancy

4. Actor
Generate action represented by code
Correct the action with critic feedback

Desktop Environment 5. Actor-Critic
Assess the success of the last action
If wrong, correct the action

2. Planner-Critic
Assess the correctness of plans generated 
by Planner

1. Planner
Generate the plans based on current state

Observe

Observe

Act

Observe

Feedback

Observe

User Query + Instructional Video

Figure 3. GUI-Thinker. An overview of GUI-Thinker, includes five proposed components: Planner, Planner-Critic, Step-Check, Actor,
and Actor-Critic. The Planner module receives the user query and an instructional video as input and generates an initial plan for the
Planner-Critic process. This plan is then refined and executed step by step. Before each step is passed to the Actor module, it undergoes
a Step-Check. After the Actor produces an action, the Actor-Critic module iteratively verifies the completion of the action and makes
corrections if needed.

3.2.2. PIPELINE OF DATA CONSTRUCTION

For each task 1) we manually collect the raw videos from
the website, 2) then manually cut the raw lengthy videos
into sub-clips, 3) ask annotators to manually write the user
queries, 4) prepare the project files for each task for repro-
ducibility, 5) generate the ground-truth plans by executing
the scripts and agent, 6) conduct the data augmentation by
varying the initial state for each task. As shown in Fig. 11,
to achieve the above six steps, we invite four annotators
and write the necessary scripts to help structure and for-
mat the data. Additionally, for the GT plan generation and
pre-action generation, we build simple agents to obtain the
data.

Raw Video Collection. We collect raw videos from the
YouTube website as there are a lot of high-quality tutorials
for desktop applications. For each software, we ask the
annotators to watch the videos and then download them
using different software.

Instruction Video Preparation. After obtaining the raw
videos, we write the script codes to cut the lengthy and
noisy videos into the sub-clips (30 seconds to 3 minutes)
that serve as the instructional video.

User Query Generation. After obtaining the instructional
videos, annotators are asked to manually write user queries
corresponding to each video. For example, a user query for
a task involving File Explorer might be: “Rename all the
files by deleting ’class’ from their names.”

Project File Preparation. Following the AssistGUI (Gao
et al., 2024), we create the project file for each task to ensure
reproducibility without relying on resource-intensive virtual
machines (Xie et al., 2024) or Docker environments (Bonatti

et al., 2024). This approach guarantees that the testing
process begins from a consistent state. When combined
with pre-actions, it enables augmentation of the same task
with various initial states.

GT Plan Generation. We write the script to accept user
query q and instructional video v as input and generate
the raw plans by agent (powered by GPT-4o). Since the
raw plans are not flawless, annotators are asked to watch
the videos and manually execute the tasks following the
raw plans. During this process, annotators edit the plans
to correct any inaccurate steps or descriptions, ultimately
producing the finalized GT plans.

Pre-Actions Generation. To vary the task, we propose
introducing pre-actions before the task begins. These pre-
actions are created by annotators and involve corresponding
scripts and agents. They are written in Python code, for
example:

from pyautogui import click,
rightClick\n rightClick(800,400). The
pre-actions primarily serve two purposes: 1) Simulating
Intermediate Task States: Pre-actions can complete
specific steps of a task, creating a starting point from an
intermediate state. This approach addresses scenarios where
users may seek AI assistance because they are unable to
complete a task. For example, if the task involves opening a
dropdown menu, the pre-action may pre-open the menu. If
the agent fails to recognize this precondition and follows its
plan to click the menu again, it might inadvertently close the
menu, causing task failure. 2) Introducing Diverse Initial
Context States: Pre-actions can also introduce variations
in the initial state, such as opening random tabs or settings.
This ensures that the starting state is unconventional,
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challenging the agent to adapt by modifying its plan or
adding new steps. See details in Fig. 8.

3.3. Evaluation

WorldGUI employs an execution-oriented evaluation ap-
proach by utilizing post-processing scripts to assess task
completion. Specifically, for tasks like Office work and
Web Browsing, we adopt exact matching to compare the
differences between the ground-truth (GT) screenshots and
the final screenshots. For tasks like File Management which
would produce new folders or change the locations of files,
etc. We create the shell script to check the status of files.

3.4. Data Statistics

WorldGUI compiles GUI tasks from 10 widely used appli-
cations on the Windows platform, including productivity
software such as PowerPoint, Excel, and VSCode. A total
of 107 meta tasks were collected from these applications,
with each task being augmented 0 to 3 times based on its
specific content, resulting in 208 augmented tasks. In total,
WorldGUI comprises 315 tasks. See the details in Sec. C.

4. GUI-Thinker: Thinking before Doing
In this section, we introduce a new comprehensive GUI
framework GUI-Thinker with a core and essential mech-
anism: critical thinking, which is vital for designing GUI
agents capable of handling dynamic environments that have
been overlooked in prior GUI agents (Hong et al., 2024;
Cheng et al., 2024; Lin et al., 2024b; Zhang et al., 2023;
Agashe et al., 2024). The GUI-Thinker includes the five
fundamental but essential components as in Fig. 3 and an
Interaction reasoning loop detailed in Algorithm 1. We
summarize our design principles in the following:

• Post-Planning Critique: After the planning phase, a
critique module verifies and, if necessary, self-corrects the
generated plans to ensure their accuracy.

• Pre-Execution Validation: Before executing each sub-
task, a validation module determines whether the subtask
should be executed. This step is crucial, as the current GUI
environment may indicate that the subtask is unnecessary or
requires modification to align with the current state condi-
tions.

• Post-Action Evaluation: After each action execution, a
mechanism evaluates whether the action was successfully
completed before proceeding to the next subtask.

These critique mechanisms ensure the reliability and adapt-
ability of GUI-Thinker in complex GUI environments.

State-Aware
Planner

Planner 
Critic

User Query: Make the text around the table

Instructional Video

Task 1: Adjust text wrapping around a Word table
Subtask 1: Click within the table to select it.
Subtask 2: Click on the 'Layout' tab in the toolbar.
Subtask 3: Click 'Properties' from the options 
available.
Subtask 4: In the 'Table Properties' dialog, go to the 
'Table' tab.
Subtask 5: Click 'Around' button.
Subtask 6: Confirm the changes to apply the text 
wrapping around the table.

Initial Plan

Corrected Plan

You need to verify whether the provided plans can fulfill the user query. If not, please revise the 
plans.
<Flag>: should be set to either true or false. If the plans are correct, selecting true, else selecting 
false.
<Feedback>: If the plan is correct, please explain why. If the plan is incorrect selecting one of the 
following error types: 'Wrong steps', 'Missing steps', or 'Redundant steps'.
<Correction>: If the plans are correct or the task is finished, output 'None', else output the 
corrected plans.
<Reason>: Please give your reasons.

Task 1: Adjust text wrapping around a Word table
Subtask 1: Click on the 'Table Layout' tab in the toolbar.
Subtask 2: Click within the table to select it.
Subtask 3: Click 'Properties' from the options available.
Subtask 4: In the 'Table Properties' dialog, go to the 
'Table' tab.
Subtask 5: Click 'Around' under 'Text Wrapping'.
Subtask 6: Confirm the changes to apply text wrapping 
around the table.  

Initial Screenshot

Instructional Video

Figure 4. State-Aware Planner and Planner-Critic. The Planner
generates an initial plan. Then, the Planner-Critic will assess the
correctness of the plan and provide necessary corrections.

4.1. State-Aware Planner

The State-Aware Planner processes the instructional video
v and user query q generates an initial plan as shown in the
left of Fig. 4. We use the speech recognition model Whisper
(Radford et al., 2023) to translate the video v into the sub-
title and then send it to the MLLM for task planning. The
task plan is hierarchically structured as p = [p1, p2, ..., pN ]
where pi is a text string describing the i-th milestone of the
task. Under each pi, there is a list of subtasks [Si

1, S
i
2, S

i
N ],

where Si
j is the j-th subtask in the i-th milestone. To ensure

the produced plans fit the GUI environment, we propose
incorporating an initial screenshot V0 to represent the cur-
rent state. This additional context allows the agent to output
plans that align with the actual state. For example, if the
instructional video suggests clicking on the “Layout” tab
in the Word application, but the current state (as indicated
by the screenshot) shows that the “Layout” tab is already
selected, there is no need to perform this action again. By uti-
lizing the visual information from the screenshot, the State-
Aware Planner can modify the plans accordingly, rather than
strictly following the guidance in the instructional video or
the existing knowledge from backbone MLLMs.

4.2. Planner-Critic

Post-Planning Critique. The goal of the Planner-Critic is
to assess the correctness of the initial plans generated by
the State-Aware Planner and provide corrections if needed.
This module is designed to ensure the accuracy of the plans
while leveraging the self-critique capabilities of MLLMs.
As illustrated in Fig. 4, for each Initial Plan, the output
consists of four components:

(1) <Flag>: Indicates whether the Initial Plan is correct.
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MLLM

Current Screenshot

Region 
Search

#Cannot confirm

New Screenshot 

You need to verify, based on the screenshot, whether the current task has been 
completed or requiring modification.
The output should be one of the following states.
<Modify>: If require modification, please either add more plans or modify current step.
<Pass>: If you think current task is unnecessary.
<Continue>: No change
<Finished>: Already Finished.
If you think current screenshot is not give all information to check the current task 
completion, please output '#Cannot confirm'.

Current Task: Subtask 1: Click on 
the 'Table Layout' tab in the toolbar.

1. Check the Step Completion.

Crop

If <Modify> or <Pass>

2. Subtask Navigation If #Cannot confirm

Invoke Region Search
Retry

Next Subtask

If <Continue>

Execute current subtask, 
go to next module (Actor)Go to next Subtask

Retry

Figure 5. Step-Check. This module first checks the step comple-
tion status via an MLLM, and then based on the output navigates
current task processing.

(2) <Feedback>: Identifies the error type, categorized
into one of three groups: “Wrong Steps,” “Missing Steps,”
or “Redundant Steps.”

(3) <Correction>: Provide the corrected plans if the
Flag indicates that the Initial Plan is incorrect.

(4) <Reason>: In addition to giving the corrected plans,
we force the model to give the reasons. As related works,
CoT (Wei et al., 2022), GPT-o1 (OpenAI, 2024), and
Deepseek-R1 (DeepSeek-AI et al., 2025) demonstrate that
generating reasoning steps along with the answer would
enhance the performance.

4.3. Step-Check

Pre-Execution Validation. After the plan assessment, a
navigation mechanism is crucial before sending each sub-
task St = Si

j at the time step t to the Actor module. To
address this, we designed a new module called Step-Check.
Through extensive investigation, we discovered that during
GUI task testing, perfect execution plans are rarely fea-
sible due to the unpredictable nature of real application
environments. Most software retains user preferences (e.g.,
remember the last configuration of user), meaning that when
executing a specific task, the plan p generated by the Plan-
ner might not align with the actual state of the software.
Therefore, the model must determine whether to proceed
with a subtask St based on the current state (screenshot: Vt,
metadata: Mt).

As illustrated in Fig. 5, we employ an MLLM to determine
whether the current task has been completed or requires
modification. We systematically categorize the possible
outcomes into four types:

MLLM
Current Task: Subtask 3: Click 
'Properties' from the options 
available.

Locate GUI 
Elements

<Success>

Based on the screenshots before and after the action, task description, software 
name, please check the task completion status.
Current Task: <Subtask St-1>
Screenshots: <Screenshot Vt-1> <Screenshot Vt>
Output: 
<Success> bool (Current task completion status) </Success>
<Reason> str (Analysis of possible mistakes if action is wrong) </Reason>

Step1: Verify the Action

Actor 
Correction

Properties... [161, 127];

If <Success> and t < max trials

Click(161, 127)

is true, 
State =<Next>

is false, 
 State =<Critic>

Actor-Critic
Next Subtask

Act&Observe

Step2: Iteratively Action Correction

Figure 6. Actor-Critic. This module includes two parts: task ver-
ification and task correction. The design follows the verify-then-
correct mechanism. We set an internal loop in this module to
iteratively correct the actions.

(1) <Modify>: Indicates that the subtask should be modi-
fied or additional subtasks should be added.

(2) <Pass>: Indicates that the current subtask is unneces-
sary and can be skipped.

(3) <Continue>: Indicates that the subtask is valid and
should be executed as planned.

(4) <Finished>: Indicates that the subtask has already
been completed and requires no further action.

In cases where the screenshot does not provide sufficient
visual information for the MLLM to determine the output,
the model outputs “#Cannot confirm”. When this occurs,
we design a Region Search module implemented by an
LLM. This module takes the corresponding GUI informa-
tion extracted by the GUI parser and the task description of
the current subtask to identify the relevant region. It then
crops the region using the generated bounding box as the
center coordinate, with the maximum width and height set
to half of the original screenshot dimensions (ensure the
region is smaller than the origin screenshot). The cropped
screenshot is subsequently sent to the Step-Check module
to regenerate the decision.

4.4. Actor

The goal of the Actor is to translate natural language subtask
St into executable code Ct. Using an MLLM as the back-
bone model, the Actor processes metadata mt and screen-

6



WorldGUI: Dynamic Testing for Comprehensive Desktop GUI Automation

Method MLLM Office Win. Usage Web Coding Media OverallMeta Aug. Meta Aug. Meta Aug. Meta Aug. Meta Aug.

AssistGUI GPT-4o 26.7 26.4 34.8 21.4 33.3 20.5 36.4 27.3 42.9 21.4 26.7
Computer Use Claude-3.5 28.9 22.0 30.4 23.8 71.4 46.2 54.5 31.8 42.9 21.4 32.4

GUI-Thinker GPT-4o 44.4 31.9 34.8 21.4 47.6 38.5 45.5 27.3 57.1 50.0 36.2
GUI-Thinker Claude-3.5 57.8 41.8 43.5 23.8 76.2 48.7 63.6 40.9 57.1 57.1 47.3

Human∗ – 88.9 85.7 100.0 97.6 95.2 82.1 81.8 81.8 71.4 71.4 87.6

Table 1. Success rate (%) of different agents on WorldGUI. Human∗ denotes the average performance of four expert participants who have
watched the instructional video only once, similar to the model. Meta represents the meta task, while Aug. represents the augmented task.

Method Office Win. Usage Web Coding Media OverallMeta Aug. Meta Aug. Meta Aug. Meta Aug. Meta Aug.

Full Model 44.4 31.9 34.8 21.4 47.6 38.5 45.5 27.3 57.1 50.0 36.2
– w/o Planner-Critic 31.1 26.4 21.7 19.0 38.1 30.8 36.4 22.7 42.9 35.7 27.9
– w/o Step-Check 31.1 30.8 21.7 19.0 33.3 35.9 45.5 22.7 28.6 28.6 29.2
– w/o Actor-Critic 15.6 11.0 4.3 4.8 28.6 23.1 0.0 4.5 28.6 28.6 13.3

Table 2. Success rate (%) of our GUI-Thinker (Full Model) with the ablation of different critical modules.

shot Vt as GUI context to generate precise executable ac-
tions, such as click(100, 200). Additionally, it lever-
ages the history of previous actions as memory to aid in
generating subsequent actions. The generated actions will
executed in the environment, and then the new screenshot
Vt+1 and metadata mt+1 will be captured for the next pro-
cessing.

4.5. Actor-Critic

Post-Action Evaluation. After generating an action, the
Actor-Critic module evaluates subtask St−1 completion and
makes corrections if necessary. As illustrated in Fig. 6, in
the first step, the module implemented by an MLLM com-
pares screenshots Vt−1 (before action execution) and Vt (af-
ter execution) while processing each subtask St to determine
the action correctness. The model outputs a <Success>
flag to indicate task completion. If the <Success> flag is
true, the current state st = <Next>. If the <Success>
flag is false (set st = <Critic>) and the number of trial
steps is below the maximum limit, the Actor-Critic module
activates the Locate GUI Elements and Actor Correction
processes. We introduce the module Locate GUI Elements
to identify the relevant GUI elements and regenerate actions
using the Actor Correction module. The corrected actions
are then executed in the environment, generating updated
observations (Ot) that include new screenshots and meta-
data for the continued Actor-Critic iteration. The process
repeats until the <Success> flag is true or the maximum
number of trials is reached.

5. Experiments
Implementation Details. We implement the MLLM in
our GUI-Thinker by using GPT-4o (OpenAI, 2023) (gpt-
4o-2024-08-06) by default. For the computer mouse and
keyboard control, we use the Python library PyAutoGUI.

Following the AssistGUI (Gao et al., 2024), we use the GUI
parser to obtain the position information of elements, e.g.,
buttons, icons, and text. We use some vision foundation
models such as Google OCR to extract the text. By default,
we use the center coordinates to represent the location of
each element. All the testing is under the same screenshot
resolution (1920 × 1080). In all experiments, we set the
max trials of the Actor-Critic to 3 for light interaction costs.
For the total trials of each task, we set it to 2×N+1, where
N is the length of subtasks Si in plan p. In most cases, we
set the trials to 21.

Evaluation. Given that our WorldGUI includes 315 GUI
tasks, we engaged four participants with strong coding and
software backgrounds to test all tasks and document their
evaluation results.

Metric. Following the previous works of OSworld and
AssistGUI, we use Success Rate (SR) as the metric.

Baselines. We compare our GUI-Thinker with two strong
approaches: AssistGUI (Gao et al., 2024) and Cluade 3.5
(Computer Use) (Anthropic, 2024). AssistGUI is a promi-
nent agent framework designed for Desktop GUI Automa-
tion, which can plan the task and then execute the task step
by step by following the query. We implement it by increas-
ing the MLLM to GPT-4o for better performance. Cluade
3.5 (Computer Use) is the strongest MLLM model spe-
cially designed for autonomous computer use. We use the
open-source implementation OOTB (Hu et al., 2024) as the
codebase and then add the subtitle of instructional videos
into the input prompt for a fair comparison.

5.1. Main Results on WorldGUI

As shown in Tab. 1, our GUI-Thinker (Claude-3.5) out-
performs previous agents, achieving the highest success
rate. Compared to AssistGUI (GPT-4o), GUI-Thinker (GPT-
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MLLM PPT Word Excel VSCode Acrobat OverallMeta Aug. Meta Aug. Meta Aug. Meta Aug. Meta Aug.

Claude-3.5 54.5 47.8 54.5 45.0 58.3 30.4 63.6 40.9 63.6 44.0 47.3
GPT-4o 45.5 39.1 36.4 25.0 50.0 34.8 54.5 27.2 45.5 32.0 36.1
Gemini-2.0-Flash 36.4 34.8 27.3 20.0 41.7 34.8 54.5 36.3 18.2 24.2 32.0

Table 3. Success rate (%) of our GUI-Thinker with the ablation on MLLM.

Method PPT Word Excel Overall

Full Model 41.2 29.0 40.0 37.0
w/o Inst. Video 35.3 22.6 22.2 29.0

Table 4. Success rate (%) of our GUI-Thinker with the ablation of
Instructional Video (Inst. Video).

4o) demonstrates superior performance in Office, Web, and
Coding GUI tasks. This demonstrates that the critical mod-
ules are essential for effectively handling complex tasks.
However, the overall success rate (SR) remains low, indi-
cating that GUI tasks in WorldGUI are still challenging, as
reflected in the Human∗ SR of 87.6%. When comparing
the Meta and augmented (Aug.) tasks, we observe that all
agents perform better on the Meta tasks but struggle with
the Aug. tasks, suggesting that current agents are not yet
effective in handling tasks with varying states. Analyzing
the results of Computer Use (Claude-3.5), we find that it
excels in Web and Coding GUI tasks, achieving a 71.4%
SR on Web tasks and 54.5% SR on Coding tasks, likely due
to its design being optimized for computer usage. These
results significantly surpass those of GUI-Thinker (GPT-4o),
which lacks the corresponding GUI automation capabilities.
Additionally, by equipping GUI-Thinker with Claude-3.5 as
the base model, our agent achieves comparable performance
in Web and Coding tasks. For the Office task, Computer
Use (Claude-3.5) struggles, likely due to the dense domain-
specific icons and buttons in these applications, which pose
challenges for perception. By incorporating Claude-3.5 as
the MLLM in our GUI-Thinker, GUI-Thinker (Claude-3.5)
achieves twice the SR (57.8% vs. 28.9%) on the Office
task (Meta), demonstrating the effectiveness of our agent
framework.

5.2. Ablation Study of GUI-Thinker

Impact of Critical Modules. In Tab. 2, we investigate
the effectiveness of our proposed critical modules: Planner-
Critic, Step-Check, and Actor-Critic. We use GUI-Thinker
(GPT-4o) as the Full Model to reduce financial costs. The
results show that removing any of these modules leads to
a decline in performance across all task groups, highlight-
ing their importance. Planner-Critic plays a crucial role
in plan correction, as its removal leads to a relative perfor-
mance drop across most tasks, particularly in Office (44.4
→ 31.1), Web (47.6 → 38.1), and Coding (45.5 → 36.4).
This indicates that effective plan refinement is essential for

successfully completing GUI tasks. Step-Check is particu-
larly important for Web and Media tasks, where removing it
results in a notable decline (Web: 47.6 → 33.3, Media: 57.1
→ 28.6). This suggests that some web-based tasks require
additional step modifications to improve execution accuracy.
Actor-Critic is the most critical module, as its removal re-
sults in the sharpest performance drop across all task groups
(Overall SR: 36.2 → 13.3). We observe that many subtasks
are difficult to execute correctly on the first attempt and
heavily rely on the Actor-Critic for additional action cor-
rection. The most drastic declines are seen in Coding (45.5
→ 0.0), Windows Usage (34.8 → 4.3), and Office (44.4 →
15.6), indicating that these tasks are more rely on the Actor-
Critic module. Overall, these results demonstrate that all
three modules contribute significantly to the performance,
with Actor-Critic being the most impactful.

Impact of Different MLLM. We also investigate the impact
of using different MLLMs in our framework. As shown
in Tab. 3, we compare three MLLMs across five popular
applications. Claude-3.5 consistently achieves the highest
performance on all five applications, particularly excelling
in VSCode and Acrobat tasks, where it attains an SR of over
60%. GPT-4o demonstrates stable performance across these
applications, while Gemini-2.0 underperforms compared to
the other two MLLMs.

Impact of Instructional Video. In Tab. 4, we study the
impact of removing the instructional video by modifying
the prompt to include only the user query for generating the
initial plan. On the three Office applications, we observe
a significant performance decline, as these tasks rely more
heavily on additional domain knowledge for successful plan-
ning. In contrast, the MLLM performs relatively well on
Win. Usage tasks, such as Settings and File Management,
where it has more inherent familiarity.

Conclusion
In this paper, we take the first step toward comprehensive
GUI agent evaluation by introducing a new benchmark,
WorldGUI. In addition to the standard static testing pro-
cesses, we incorporate dynamic testing procedures to ensure
that WorldGUI effectively captures the complexity and dy-
namism of real-world GUI environments. Furthermore, to
enhance GUI automation, we propose a novel agent frame-
work, GUI-Thinker, built upon a critical thinking philosophy
and comprising five core components. This framework en-
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ables the agent to dynamically identify uncommon states
and adjust its plans or actions accordingly. Finally, we eval-
uate the latest computer-using agent, Claude-3.5, using our
WorldGUI benchmark, demonstrating the effectiveness of
GUI-Thinker across a variety of GUI tasks.

Impact Statement
This paper introduces WorldGUI and GUI-Thinker, a bench-
mark and agent framework designed to advance the field of
GUI automation. Our work has several important societal
and research implications. Firstly, WorldGUI represents a
significant step toward comprehensive GUI agent evalua-
tion by incorporating diverse initial states for each GUI task.
This approach better reflects real-world conditions, inspiring
future GUI-related benchmarks to emphasize realistic GUI
testing scenarios in their designs. Secondly, we propose a
holistic GUI agent framework, GUI-Thinker, which inte-
grates five essential components and an iterative reasoning
loop. By embedding critical thinking into its module design,
GUI-Thinker enhances adaptability in complex and dynamic
GUI environments, allowing agents to handle unpredictable
interface changes more effectively. Our work lays a strong
foundation for future research in adaptive, reasoning-driven
GUI automation, with potential applications in software
testing, accessibility tools, and intelligent user assistance
systems.
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A. Comparison with other benchmarks
In this section, we summarize the data statistics of other benchmarks in Tab. 5 as the comparison. We can observe that the
main difference of our WorldGUI is we incorporate various initial states to stimulate the real GUI automation while other
benchmarks are not considered.

Benchmark Softwares Tasks Platform Task Focus Inst. Video GT Plan Various States

WebArena (Zhou et al.) 6 812 Web Website Usage ✗ ✗ ✗
VisualWebArena (Koh et al., 2024) 3 910 Web Website Usage ✗ ✗ ✗
Mobile-Eval (Wang et al., 2024) 10 30 Android OS APP Usage ✗ ✗ ✗
APPAgent (Zhang et al., 2023) 10 50 Android OS APP Usage ✗ ✗ ✗
OSWorld (Xie et al., 2024) 10 369 Ubuntu+Win. Software Usage ✗ ✗ ✗

AssistGUI (Gao et al., 2024) 9 100 Windows Productivity Software Usage ✓ ✗ ✗
VideoGUI (Lin et al., 2024a) 10 86 Win. + Web Productivity Software Usage ✓ ✗ ✗
WindowAgentArena (Bonatti et al., 2024) 11 154 Windows SoftWare Usage ✗ ✗ ✗
WorldGUI 10 315 Win. + Web Productivity Software Usage ✓ ✓ ✓

Table 5. Comparison with related benmarks. WorldGUI is a unique benchmark that has the various states for each task to stimulate the
real-world agent-computer interactions.

Why Instructional Video? The rationale for using instructional videos is that, in some cases, completing a task requires
extensive configuration, making it impractical to provide all necessary information within the input query. As illustrated
in Fig. 7, our user query is “Generate a photo of a girl with short brown hair with EasyNegative to improve the quality”,
which does not specify how to improve the quality. The instructional video will serve as contextual information to guide the
agent to complete that.

User Query: Generate a photo of a girl with short brown hair with ControlNet to 
improve the quality.

Task 1: Set Up the Image Generation Parameters
Subtask 1: Click on the input text box
Subtask 2: Enter "1 girl, solo. brown short hair, green eyes, round glasses, smile, 
simple background, braided hair" into the Prompt field.
Subtask 3: Add "green background" to the Negative Prompt box to exclude this 
color in the background.
Task 2: Enhance Negative Prompt Settings
Subtask 1: Include "Textrual EasyNegative" in the Negative Prompt box for 
improved exclusion of unwanted elements.
Task 3: Configure Advanced Settings in ControlNet
Subtask 1: Select the "Euler a" Sampling method for image generation.
Subtask 2: Enable the "Low VRAM" option to optimize resource usage.
Subtask 3: Turn on "Pixel Perfect" to enhance image quality.
Task 4: Initiate the Image Generation Process
Subtask 1: Click the 'Generate' button to start the image creation process using 
ControlNet settings.

Figure 7. An example of using Stable Diffusion for media creation in WorldGUI. The left shows the interface of using stable diffusion to
create the photo. The right shows the user query and GT plan. If no instructional video, it is hard to include all the settings

B. Details of Actor Space
In this section, we detail the action space used in our WorldGUI. Our action space includes all raw mouse and keyboard
actions, such as left-click, right-click, double-click, drag, keystrokes, and key combinations for shortcuts, among others.
Mouse-related actions also specify the target position in the pixel space of the observed screenshot. To ensure a universal
and comprehensive representation of actions, we adopted the widely used Python library, PyAutoGUI, for controlling mouse
and keyboard inputs. Each action is represented using the syntax action type(arguments) as in Tab. 6.

C. Data
(1) Annotators. In this work, we have four annotators: A, B, C, and D. The team comprises one PhD student, one Master’s
student, and two undergraduate students. Prior to annotation, all annotators receive training on using the applications in
WorldGUI to ensure high-quality annotations. For the 10 desktop applications, we divide the software into four parts,
assigning each part to a different annotator. For the human tests presented in Tab. 1, the annotators demonstrate tasks on
software that they did not annotate. As shown in Tab. 5, each annotator is responsible for different software during both the
annotation and human testing phases to make the soundness of the Human Test results.
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Action Type Example

Mouse Movement moveTo(120, 200)
Mouse Clicks click(200, 300)
Keyboard Type write(’classes’)
Hotkey hotkey(’ctrl’, ’a’)
Scrolling scroll(-100)
Drag dragTo(120, 220, 2)
Mouse Down and Up mouseDown(); mouseUp()
Press Keys press(’delete’)
Key Down and Up keyDown(’shift’)

Table 6. The action types and its example in WorldGUI.

Annotators Annotation Phase Human Test Phase

A PowerPoint, Word, Excel VSCode, Stable Diffusion, Web
B Adobe Acrobat, Stable Diffusion Excel, Settings
C Settings, Web PowerPoint, File Explorer, Youtube
D VSCode, File Explorer Word, Adobe Acrobat

Table 7. This table shows the software used during the annotation and human testing phases by different annotators.

(2) Data Construction Pipeline. For each task 1) we manually collect the raw videos from the website, 2) then manually
cut the raw lengthy videos into sub-clips, 3) ask annotators to manually write the user queries, 4) prepare the project files
for each task for reproducibility, 5) generate the ground-truth plans by executing the scripts and agent, 6) conduct the data
augmentation by varying the initial state for each task. As shown in Fig. 11, to achieve the above six steps, we invite four
annotators and write the necessary scripts to help structure and format the data. Additionally, for the GT plan generation and
pre-action generation, we build simple agents to obtain the data.

(3) Project File and Enviroment Configuration. In this paper, we utilize project files to ensure the reproducibility of
task executions. This approach is simpler and more cost-effective compared to using virtual machines (Xie et al., 2024)
or Docker environments (Bonatti et al., 2024). The types of project files for each application are illustrated in Tab. 8. To
enable cross-platform usage, such as controlling the computer via a phone or other systems, we implement a frontend and
backend system. The frontend receives user queries, captures screenshots and metadata, and then sends this information to
the backend for API calls and the invocation of local vision foundation models. Cross-platform support allows us to deploy
autonomous agents in a simple and cost-effective manner.

(4) Creating Augmented Tasks. In our study, to stimulate dynamic testing processing in real GUI interactions, we propose
to design GUI tasks with various initial tasks. Specifically, we propose pre-actions before executing the task. The pre-actions
primarily serve two purposes: 1) Simulating Intermediate Task States: Pre-actions can complete specific steps of a task,
creating a starting point from an intermediate state. This approach addresses scenarios where users may seek AI assistance
because they are unable to complete a task. For example, if the task involves opening a dropdown menu, the pre-action
may pre-open the menu. If the agent fails to recognize this precondition and follows its plan to click the menu again, it
might inadvertently close the menu, causing task failure. 2) Introducing Diverse Initial Context States: Pre-actions can
also introduce variations in the initial state, such as opening random tabs or settings. This ensures that the starting state is
unconventional, challenging the agent to adapt by modifying its plan or adding new steps. We illustrate one example in
Fig. 8. Here, the meta task and augmented task, have the same user query and instructional video and it will ideally have the
same final state. We additionally provide more examples about augmenting the meta task in Fig. 9.

(5) Data Statistic. WorldGUI comprises 315 GUI tasks sourced from 10 widely used Windows applications, including
PowerPoint, Excel, Word, Adobe Acrobat, VSCode, File Explorer, Settings, Web, Youtube, and Stable Diffusion. Here we
provide the details about the task activities and project file for each application in Tab. 8. We collected 107 meta tasks from
these applications, each of which was augmented 0 to 3 times based on its specific content, resulting in 208 augmented tasks.
Fig. 10 presents the task distribution, provides query examples, and illustrates the distribution of meta and augmented tasks
across different applications.
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User Query “Set the document to Two Page View from the View menu.”

Task 1: Change the page display to two-page 
view in Adobe Acrobat
Subtask 1: Click 'View' in the top menu.
Subtask 2: Hover over 'Page Display' from the 
dropdown menu.
Subtask 3: Click 'Two Page View' to display the 
document in a two-page layout.

GT Plans Initial State Pre-Action

Task 1: Change the page display to two-page 
view in Adobe Acrobat
Subtask 1: Hover over 'Page Display' from 
the dropdown menu.
Subtask 2: Click 'Two Page View' to display the 
document in a two-page layout.

Task 1: Change the page display to two-page 
view in Adobe Acrobat
Subtask 1: Ignore the Tool Page and Click 
'View' in the top menu.
Subtask 2: Hover over 'Page Display' from the 
dropdown menu.
Subtask 3: Click 'Two Page View' to display the 
document in a two-page layout.

Original Data

Augmented 
Data

Figure 8. An example of augmenting one GUI task with manually aug the initial state and then using the execution scripts and corresponding
agents to obtain the pre-action for each augmented case.

Applications All Task Task Activities Project File Type

PowerPoint 34 Change the content style and layout; Design new effects. project.pptx
Word 31 Formatting the content style and layout project.docx
Excel 35 Table formatting; Data management and processing project.xlsx
Adobe Acrobat 36 Automatic add electric signature; Document management project.pdf
VSCode 33 Code editing; Software configuration vscode.exe
Settings 39 Advanced personalized and safety settings; ms-Settings
File Explorer 26 File management: Add, delete, rename, and move files. explorer.exe
Web 32 Web operation web browser + URL
Youtube 28 Video and account configurations web browser + UR
Stable Diffusion 21 Media creation with complicated effects Local Run Platform

Table 8. This table shows all tasks, task activities, and project file of the desktop applications used in WorldGUI.

D. GUI-Thinker Reasoning Loop Algorithm
In this section, we provide the details of our reasoning loop algorithm in Algorithm 1.

E. Qualitative Results
(1) In Fig. 12, we present a successful prediction example, demonstrating that the WorldGUI can effectively plan each step
for a task, accurately perceive specific elements in the GUI, and convert them into the correct action code. Additionally, we
display the parsed GUI elements, which can accurately identify most content, including small icons and dense text elements.

(2) We provide the visualization results of using Planner-Critic, Step-Check, and Actor-Critic in Fig. 14, Fig. 15, and Fig.
16. These qualitative results demonstrate the effectiveness of these critical modules in GUI automation.

(3) We also highlight some common errors encountered. 1) The model has the difficulty of obtaining the desired information
when we augment the task by invoking the dropdown menu of the Settings application. As shown in the left of Fig. 17,
when we click on the ’System’ button on the left, it is challenging for our model to extract the button’s position as it is
hidden. Such cases require the model to have a higher level of ability to delete the content in the input box or click on the
blank area. 2) As shown in the right of Fig. 17, the model has difficulty dragging a bar to achieve the desired value. 3) The

13
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Meta Aug 1 Aug 2

Meta Aug 1 Aug 2

Query 1: Add a note to the second ppt, the content of the note is 123

Query 2: Make the text around the table

Pre-actions: None Pre-actions: Click on slide 3. 
It may mislead the planner to omit adding the 
step 'click on slide 2' because of the concept of 
slide 1, 2, 3 is not easy to obtain only from 
screenshot.

Pre-actions: Click on the “Replace” button in the 
Home ribbon. 
It augments the context of performing the task. 
The agent should understand the current state 
and then close the pop-up window to continue 
the process.

Pre-actions: None Pre-actions: Click on “Design” Tab.
It make the context changed. The agent should 
not mislead by current state.

Pre-actions: Click on “Table Layout” to stimulate 
the intermediate initial state.

Figure 9. We present the examples of conducting the augmentations from the meta task.

model struggles with the visual choice when there is no text information in the screenshot, as shown on the left of Fig. 18.
The subtask aims to select the center button, but the current model makes it hard to detect the center choice only from the
screenshot. 4) The model cannot successfully locate the position of the input box, as the GUI parser will easily locate the
text location ’Replace with’, it always outputs the action like clicking on the ’Replace with’, which will destroy the whole
task success.
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Figure 10. Distribution of collect tasks, selected queries, and task amount of WorldGUI. We have gathered tasks across 10 desktop
applications, focusing on the use of productivity software as well as fundamental computer operations and settings.

01
02

03
04

05
06

Raw Video Collection:

 Find potential Computer Use Full 

Videos from Youtube (PPT, Word, Excel) 

or official software website.

Inst. Video Preparation: Human 

checks to cut the Video Clips (30s to 

maximum of 3 mins) as Inst. Video.

User Query Generation:

Manually write a User Query 

for each instructional video.

GT-Plan Generation:

Use the Agent to generate Initial Plans 

and then ask the annotators to verify and 

correct the error plans.

Project File Preparation:

Create the Project File for each 

task. It ensures the reproducibility.

Pre-actions Generation:

 Augment each task and 

generate Pre-actions.

Human

Code

Agent

Figure 11. Pipeline of Data Construction. Human: Represents the annotators. Code: Refers to the scripts (e.g., Python Code) utilized to
achieve the goal. Agent: We design an agent built upon the MLLMs to achieve the goal.

Subtask 1: Open the 'Settings' application on your PC. Subtask 2: Click on 'System' in the left sidebar. Subtask 3: Click on 'Notifications' from the available options.

Subtask 4: Scroll down to the 'Notifications from apps 
and other senders' section.

Subtask 5: Locate the 'Battery saver' item in the list.
Subtask 6: Toggle the switch next to 'Battery saver' to the 
'Off' position to disable notifications.

Shortcut: Win+I

Scroll Down

Figure 12. We show one successful prediction of our GUI-Thinker.
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Algorithm 1 GUI-Thinker Reasoning Loop Algorithm
Input: State s, Action Code C, Screenshot V , Metadata m, Current subtask S, Critic count z
Generate task plan p with Planner and Planner-Critic
Initial current subtask St=0 = S1

1 , where S0
1 is the 1-th subtask in the 1-th milestone of p.

Initial s0 = <Continue>
while St is not end and t < max trials do

Observe metadata mt and Screenshot Vt from Env.
Obtain state st by running Step-Check.
if st = <Next> then

Go to the next task St+1 = next(St)
end if
Check potential modification of subtask St

Obtain action code Ct by running Actor; Execute the action code Ct in the Env.; Observe metadata mt and Screenshot
Vt from Env.
Set Ct = None; t = t + 1; Set state st = <Critic> (For each subtask, the first step is finished, then execute the
actor-critic process)
Observe metadata mt and Screenshot Vt from Env.
Running Actor-Critic and obtain the state st
if st = <Next> then

Go to the next task St+1 = next(St).
end if
while st = <Critic> and z < max critique trials do

Running Actor-Critic and obtain the state st and corrected action code Ct

if st = <Next> then
Go to the next task St+1 = next(St).

end if
Execute the action code Ct in the Env.; Observe metadata mt and Screenshot Vt from Env.
Set Ct = None; z = z + 1

end while
Go to the next task St+1 = next(St)
t = t+ 1

end while

Figure 13. We show two examples of using GUI Parser to obtain the element position information.
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Task 1: Format the whole document into two columns
Subtask 1: Click on the Layout tab.
Subtask 2: Click the Columns command.
Subtask 3: Click on Two to format the document into two 
columns.

Initial Plan

<Feedback>Missing steps. The current plan does not include selecting all the text in the document before applying the column 
format, which is necessary to ensure the entire document is formatted into two columns.</Feedback>
<Flag>false</Flag>
<Correction>
Task 1: Format the whole document into two columns
Subtask 1: Click on the Home tab.
Subtask 2: Click anywhere in the text area and press Ctrl + A to select all the text in the document.
Subtask 3: Click on the Layout tab.
Subtask 4: Click the Columns command.
Subtask 5: Click on Two to format the document into two columns.
</Correction>
<Reason>The user query is to change the whole document from one column to two columns. The current plan does not include 
selecting all the text in the document, which is necessary to apply the column format to the entire document. The correction 
includes selecting all text before applying the column format, ensuring the entire document is affected.</Reason>

Planner Critic

Screenshot

Output

Figure 14. An example of using Planner-Critic to correct the plan.

Previous Finished Tasks: Subtask 1: Click on the text "US 
SUBMARINE DAY" within the main Slide Pane to select it.
Current Task: Subtask 2: Go to the "Font" group on the toolbar.
Next Task (for reference, you should consider whether current task is 
necessary when we complete next task ): Subtask 3: Type "40" in the 
font size box to set the font size to No. 40.

<Finished>
<Reason>The "Font" group on the toolbar is already visible in the 
screenshot, indicating that the current task of going to the "Font" 
group has been completed.</Reason>

Screenshot

Previous Finished Tasks: …Subtask 2: Click the Insert tab in the 
PowerPoint toolbar. Subtask 3: Click the Table command.
Current Task: Current Task: Subtask 4: Mouse over the grid to 
select a 3x3 table.
Next Task (for reference, you should consider whether current task is 
necessary when we complete next task ): Subtask 5: Click to insert 
the table with the selected number of rows and columns.

Output: <Continue>

Screenshot

Input

Output

Output

Input

Figure 15. Two examples of using Step-Check to check the subtask status.
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<Success> True </Success> 
<Reason> The action to click on cell A18 was successfully completed. The second screenshot shows that cell A18 is selected, as indicated by the 
highlighted cell and the cell reference "A18" in the Name Box. </Reason> 

Based on the screenshots before and after the action, subtask description, software name Excel, please check the action completion status.
Current Task: Subtask 1: Click on cell A18 to select it
current action: from pyautogui import click\nclick(17, 675)
Parsed GUI Screenshot Info: [Note that: element format is "name [its position]", separate with comma]
Excel:
  elements:
    Status Bar [960, 1006]; Status Bar [960, 1006]; Status Bar [960, 1006]; Cell Mode Ready [33, 1007]; Macro Recording Not Recording [85, 1007]; 
Accessibility Checker Accessibility: Good to go [198, 1007]; Average 152364686.9 [1126, 1007]; …

Screenshot Before Action Screenshot After Action (Crop for best view)

Input

Output

Figure 16. An example of using Actor-Critic to correct the actions.

Subtask: Navigate to the 'System' section.

Query 1: Turn on Storage Sense

Error: The dropdown menu hides the “System” button. Thus 
the GUI Parser and MLLM cannot find the “System” in this 
screenshot.

Subtask: Drag to set brightness to 70%

Query 2: Set the brightness under Dynamic Lighting with 70%

Error: The Actor cannot provide exact bbox to achieve the goal of 
dragging to 70%.

Figure 17. We display some common errors.
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Subtask: Select 'Center'

Query 1: Format the slide background with gradient fill

Error: The Actor Model cannot identify the “center” button 
in this dropdown menu

Subtask: Enter 'RA' in the field behind the 'Replace with' text.

Query 2: Replace all the 'Reading' in the text with 'RA'

Error: The Actor cannot click on the input field as the parsed 
bbox is the position of text “Replace with”

Figure 18. We display some common errors
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